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Summary

Waterhammer in piping systems results in unbalanced forces, particularly between changes in direction
such as elbow pairs, and changes in area such as valves, reducers and other inline components. It is not
uncommon for these forces to cause damage when a system is not properly designed to accommodate
them; resulting in failed restraints, overloaded equipment, large displacements and overstressing, or even
failure of pipe and fittings as illustrated in the photographs below.
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In some cases, hand calculations and conservative assumptions can be used to predict the magnitude,
direction, location and timing of these dynamic loads. In many cases however, the complexity of
waterhammer loading renders manual methods useless, thus requiring computer analysis to properly
predict the loading seen in a piping system.

Once these loads are determined, pipe stress software can be used to evaluate the piping system
response, such as deflections, restraint loads, equipment loads and stresses.

This paper examines a waterhammer event caused by the partial closing of a valve in a relatively simple
system. The hydraulic transient analysis is performed using AFT Impulse™, and the mechanical system
response is then evaluated using Intergraph’s CAESAR Il ® pipe stress analysis software.

One direct benefit of using these two particular applications is that AFT Impulse creates force-time data
files for direct import into CAESAR 1.



For those who use both of these applications, this paper will also help show you how to create,
transfer and apply waterhammer force-time data using these two software applications.

Nomenclature Subscripts

A =Area 1  =location 1
F  =Force 2  =location 2
m = momentum I = imbalanced
P =Pressure X = x direction
V = Velocity y  =ydirection

dP = change in pressure
c = speed of sound (wave speed, celerity)

dV = change in velocity

Introduction

Waterhammer is a transient phenomenon that occurs in liquid piping systems when some event causes a
departure from steady state. When a transient is initiated, a single, or series of coupled pressure/velocity
waves are generated and travel near the speed of sound through the piping system.

Events that cause waterhammer include:
e Valve closure or opening (in full or in part),
e Pump speed change (trip or startup)
¢ Relief valve cracking open
e Rapid tank pressurization

e Periodic pressure or flow conditions

Typically an engineer’s primary interest is transient peak pressures that result from
waterhammer, allowing proper selection of pipe strength and design for general safety and
equipment protection.

Discussion of Force Balance

Once the analyst ensures that peak-pressure limits are not exceeded during a transient event, attention is
typically turned to transient forces and how the system will respond to these forces.

Traditional Force Calculations (i.e. manual calculations) consider the loads caused by a sudden
change in pressure, and follow this pressure change as it moves through the pipe from its source to a
termination point at roughly the speed of sound. Between elbows, there is a static pressure force that is
exerted on each elbow along the axis of the pipe, equal to the pressure multiplied by the inside area of



the pipe. During the short duration where one elbow sees the elevated pressure while the next one does
not, there is a net-differential force acting on the elbow pair that can be quite significant. Once the
elevated pressure reaches the next elbow, the pressures equalize and the differential load between the
elbows disappears.

Figure 1 illustrates this force imbalance where the flow has been stopped downstream and the transient
pressure wave is traveling opposite to the original flow direction. For some finite duration of time, the
pressure is higher at node 2 than node 1, causing a net unbalanced pressure force in the direction of the
original flow.
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Figure 1. Force imbalance at an elbow pair using the traditional method of pressure difference

Based on Figure 1 the traditional force imbalance calculation is:
Pl,xAl,x + PZ,XAZ,X = Fl,x (l)

Assuming that your hand-calculated pressure rise is reasonably accurate, this method is reliable for
simple systems such as in Figure 1, but the introduction of in-line components adds a level of
complexity that quickly renders these calculations useless. For example, if we introduce a valve in the
line and partially close it, some difficulties arise for the manual calculation method.
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Figure 2. Pressure force balance with in-line component



The traditional hand-calculation in this scenario would be an attempt to sum all of the pressure forces
acting at both elbows and both sides of the partially closed valve. With a partial valve closure, what are
the magnitudes of the transient pressures? What pressure loads are acting on each side of the valve? As
each pressure wave travels up and reflects back down each leg, how do these loads match up over time
at the elbows and at each side of the valve? With these complexities, the accuracy of our manual
calculation becomes highly suspect.

The ability to perform a comprehensive, computer-based hydraulic transient analysis allows us to
consider all of the loads occurring in the line: pressure forces, hydraulic forces at components, friction
and momentum, as they all change over time, and while achieving an accurate representation of the
transient event and resulting loading.

Enhanced Force Calculations consider all hydraulic loading.
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Figure 3. Force balance between elbow pairs using an enhanced method

Based on Figure 3, the enhanced force balance calculation is:
Pl,xAi,x - rhl,xvl,x + P2,xA2,x - mz,xvz,x + Z I:x,friction = I:I,x (2)

Example AFT Impulse Model

Figure 4 shows the model used for this example. The total pipe length of 315 meter is 20” diameter,
standard wall thickness, flowing water at 18 C. The transient event is the partial closure of valve J2,
from 100% flow to 10% flow over 2 seconds, with a Cv profile as shown in Figure 5.
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Figure 4. AFT Impulse model of system with a valve transient

AFT Impulse does not work on the basis of a three-dimensional interface because that is an unnecessary
complication when performing flow analysis. Instead, a two-dimensional diagramming approach with
component elevation is employed. The model shown in Figure 4 has the appearance of an isometric
view because creative use was made of AFT Impulse drawing features.

A Few Calculations

When a valve fully closes quickly, the magnitude of the resulting pressure rise in a liquid can be
conservatively estimated using the equation:

dP =p c AV (fluid density, speed of sound, change in velocity)

With our valve closing 90%, one might presume we could guess at the pressure rise using 90% of the (p
¢ AV) magnitude. It turns out that this is incorrect by an order of magnitude. (How do we figure that
out? In this case, through analysis using AFT Impulse.) Without a good ball-park pressure-rise value,
our manual method is already in trouble. How do we apply this pressure to the partially closed valve
area? More uncertainty. It’s at this point that, even if we want to do a manual PA calculation, we’ll
need to rely on a computer-based transient hydraulic analysis to get the pressure data.



AFT Impulse - Valve closure with pipe forces SLimp - [Graph Results] | = | = X |

@Eile Edit View Analysis Database Arrange Options Window Help - | = ﬁ
EEHE S & B0 & R v | | Ele BBy

Valve Cv vs. Time

15000
-

O 10000
L)
=
m

> # Junction 5
5000
0
0 2 4 6 8 10
Time (seconds)
e ] |Gl rorenesty] SEUNEROElY] SRR TSR] | Scenario: Metric Units s [=s

Figure 5. Valve Transient: Cv vs. time. 100% flow to 10% flow in 2 seconds.

AFT Impulse Model Results

Traditional Approach

In reference to Figure 3, when calculating loads by hand, the stress analyst would typically attempt to
sum the Pressure x Area (PA) forces acting on both elbows and both sides of the valve. As mentioned
earlier, with a partial valve closure, predicting the pressure rise by hand is problematic, and the PA loads
on the valve are difficult to determine. To get useful values, one would run a transient hydraulic
analysis. This begs the question: “if you need to do a transient analysis to get the pressure rise and valve
loading in order to get a meaningful hand-calculation, why not just get the software to do the entire
task?”.

For simplicity, one might consider neglecting the loading at the valve and just hand-calculate the forces
between the elbows. We’ll demonstrate the flaw in this assumption by comparing the force-time data
that results from first neglecting, then including the loads acting on the partially-closed valve in the leg
of pipe between the elbows on either side of it.

Figure 6 shows the PA force differential between the second elbow pair (from Figure 4), neglecting all
other loading in this leg.
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Figure 6. Imbalanced forces between second elbow pair neglecting friction & loads on the valve

One observation that can be made from Figure 6 is that neglecting friction and momentum loads results
in non-zero steady-state loading. At time zero, before any transient has occurred, the force imbalance is
about +5800N. After 2 seconds, the force imbalance oscillates and with additional time will eventually
decay to a final steady-state value of about +19600 N. However, the time zero and final steady-state
imbalanced forces should be zero because there are no force imbalances across this elbow pair under
steady-state conditions.

This is something that we neglect in our hand-calculations for three reasons: 1) it is the sudden changing
of the load that causes our dynamic response, so we can neglect the steady-state loads without
influencing the dynamic analysis of the event, 2) the magnitude of the steady-state friction loads are
relatively small, and 3) we don’t want to spend the time required to hand-calculate the exact answer.

That being said, it is nonetheless analytically pleasing to properly include and consider all loads, steady-
state or transient, and obtain a full, true picture of the physical event.

It needs to be understood that, in the AFT Impulse software, there is an option where you choose
whether to “include friction and momentum” between two points, which actually means:
“including all hydraulic losses and PA differences”, not just pipe-wall friction and momentum.
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This has a very helpful implication. All loads on pipe & inline components between two points on one
axis will be properly considered by simply identifying the two points, and turning on the momentum &
friction settings. There is no need therefore, to identify all of the intermediate points, such as each side
of a valve, filter, reducers, or other inline components and sum up the loads; this is done automatically,
which makes the task of defining the force-time parameters quite trivial.

Enhanced Method Results

Figure 7 shows the imbalanced force across the second elbow pair (from Figure 4) including all loads in
the force balance as shown in Equation 2.

Here one sees that at time zero, the force imbalance is zero. Further, after 2 seconds the force imbalance
oscillates and approaches zero and will eventually decay to zero. This is in accordance with the fact that
under steady-state conditions there is no force imbalance at this elbow pair.
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Figure 7. Imbalanced forces at second elbow pair using enhanced method.



Figure 8 compares the results from Figures 6 and 7 in one graph.
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Figure 8. Comparison of imbalanced forces at second elbow pair.

It can clearly be seen that neglecting the valve loading leads to incorrect results. Not only do we see an
error in the magnitude of the loading, we also see an entirely different direction of loading. The reason
for this can be explained using Figure 9 below. By neglecting the load at the valve, the dominant load

10

and direction occurs when the pressure rise reaches the elbow on the left, creating a net positive Z-

direction load. When all loads are included, the load on the upstream side of the valve is dominant, and
acts in the opposite direction. This is demonstrated by the offset of the timing of the maximum loading
in each case. The pressure (and force) at the valve increases at an earlier point in time than the force at

the upstream elbow, because the pressure must travel from the valve to the elbow.
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Figure 9. Comparison of imbalanced forces at second elbow pair.

Method Maximum (N) Minimum (N)
Neglecting Valve & 61,500 5,100
other loads

Including All Loads 1,450 -39,300

Figure 10. Maximum and minimum values of imbalanced force for second elbow, including and
neglecting valve loads.

This underscores the importance of including all loading, and with the uncertainty of the real
loading on components between the elbows using hand-calculations, also demonstrates the
importance of relying on computer-based analysis for easily-obtained, realistic results.

For completeness, Figure 11 shows the imbalanced force across the first elbow pair (from Figure 4)
using the enhanced method which includes all forces as shown in Equation 2. The filter in this vertical
line also poses a problematic scenario for hand-calculation methods.

Note that all of the force data generated can be exported to an ASCII file or copied to the Windows
Clipboard and easily manipulated in Excel or other software. The force data generated by AFT Impulse
is not restricted for use with CAESAR I1. Side calculations in Excel or in-house software can be easily
performed with this data.
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Figure 11. Imbalanced forces at first elbow pair using enhanced method.

Exporting AFT Impulse Results to CAESAR Il

In CAESAR I1 there are two methods that can be used to dynamically evaluate impulse loading: Time-
History analysis and Spectral analysis. Time-History analysis performs the time-slice integration
required to accurately ‘observe’ the behavior of the system through each step of the transient event.
That is, we can see at any point in time what is happening at each point in the system through the
analysis.

In contrast, Spectral analysis predicts only the maximum response of individual natural frequencies in
the system, and then sums these responses in an SRSS type of fashion. For this reason, Time-History
analysis is the more accurate of the two methods.

In spite of this superior accuracy, the CAESAR |1 utility that imports AFT Impulse force-time data is, up
to version 6.10 (a.k.a. 2013 R1), only designed to setup the CAESAR Il input for Spectral analysis. It
may be preferred to use Time-History analysis, which requires a more manual process than the AFT
import utility. We will explain the steps required for both methods.
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AFT Impulse Import / Spectral Analysis Method

After the AFT Impulse simulation is complete, the results can be exported to a file that is formatted for
use by the CAESAR Il AFT Impulse import utility. In Impulse, this is done using the “File” drop-down
menu with the “Export Force File” option (Figure 12), which launches the Export CAESAR Il window
(Figure 13).
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Figure 12. The AFT Impulse File menu has a feature for exporting files for CAESAR II. Note that
this feature is only visible on the File menu when working in the Output, Graph Results or Visual
Report window.
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Figure 13. AFT Impulse’s Export CAESAR Il force file window using enhanced method, which
includes friction and momentum.

Here, users can select which force sets they want to export, the force and time units, and whether to
neglect or include friction and momentum.

A limitation of CAESAR 11 through version 5.30 (2011) is that its AFT Import utility can handle a
maximum of 2500 data points, whereas AFT Impulse may generate a force file with more than this.
When more than 2500 are generated, the user will need to adjust the data set exported by setting a user-
specified time frame, and/or by selecting a wider time-step between data points.

Usually, the transient events of interest to the stress analyst are less than a few seconds in duration, so a
30-second Impulse analysis duration can often be quite easily narrowed to a specific time-frame of
interest.

Note that CAESAR 11 expects to receive this data in time-units of seconds using the AFT import
utility, while CAESAR 11 users familiar with the dynamic input are accustomed to entering time
data manually in millisecond units.
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Figure 14. CAESAR Il force files are in ASCII format and can be viewed with Windows Notepad.

There is no transfer of the input piping model data from Impulse to CAESAR II; this must be created
independently, and it is presumed that the CAESAR |1 file is ready for use by the AFT Impulse import
utility in the next steps.

To import the force-time data for Spectral analysis, we access the AFT Impulse utility through CAESAR
II’s Tools drop-down menu:

Tools > External Interfaces > AFT Impulse
which will launch the following dialog:
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" AFTIMPULSE TRANSFER - GENERATE DLF FILE
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| Browse

Hydraulic Mame CAESAR Il Node Name

COMPUTATION IN PROGRESS

AFT Component;

Caesar |l Mode Mumber;

DLF Filename:

Current Mode:

Current Frequency:

Current Time Step:

tdax. points on each DLF curve:

Frequency Cut-off (Herz): 100 [ 0K l [ Cancel l

Figure 15. The dialog will first show up with blanks in most fields. You should use the Browse
button to locate and load the force file. This is a dialog window in CAESAR II.

More than one force-time data set can be stored in one force-time file, which can represent the loading at
several points in the piping system.

In this example, we have selected one force-file that contains two force-time profiles for two elbow
locations being loaded. The selection of force-time data for both legs was done in Impulse. If you
export individual force-time data for single legs of pipe in separate force-time files, CAESAR Il will not
let you combine them afterward in this dialog. To combine multiple force-time profiles for multiple
pipe legs, you must export them at the same time into one file in Impulse.

You next click your mouse on each of the force files in order to activate the prompt required to specify
the node numbers in the CAESAR 1l model where the loads will be applied. For this model, we are
applying the loads at nodes 300 and 150.

You may wish to adjust the number of data points that will be used to represent the response curve, and
you may sometimes need to adjust the maximum value on the frequency axis of the response curve.
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Figure 16. AFT Impulse import dialog. This is a dialog window in CAESAR II.

Each of the two force files loaded in this example will be used to create two separate response curves
that CAESAR 11 will use to predict how each natural frequency in the system will respond to each load.

When you finish the selections & click the Ok button, CAESAR |1 warns you that the force data in the
force-time files lack directional information. AFT Impulse does not “speak” in the XYZ terms that are
understood by CAESAR II; it relies on non-directional lengths and elevations. This means that the user
is required to specify the direction of the loads after CAESAR 11 creates the dynamic input.

Warning

The current dynamic force fle containg uni-drectional data.

If & CAESAR. 1T dynamic input file is generated with this data, the force wil be assumed

to actin the "Global X" direction. This should be checked for accuracy from the CAESAR 1T
dynamic input module.

You are next asked whether you want CAESAR 11 to create the dynamic input.
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YWould you like to create a
Dynamic Input File MNow?

If you click YES, you will then need to choose the CAESAR |1 file that will have the dynamic input
added to it. When you next open CAESAR II’s dynamic input, you will see the input created, starting
with the definitions of the response spectrum graphs that were created in the Spectrum Definitions tab.
You may need to scroll down the list to see them, as CAESAR Il does automatically list other built-in
spectra. These additional spectra can be safely deleted from the list to tidy-up the input if you wish, by
highlighting the unwanted lines of data (using the gray column on the left) and the red * - button.

& Dynamic Analysis - [Z\SEMINARS\CAESAR T SEMINAR' VIEMORY STICK I SEMINAR FINISHED FILE

: File Edit Tools
i Analysis Type: Water Hammer /Slug Flow (spectrum) Qe s e Ié E ’y

Spectrum Definitions | Foree Gets | Spectium Load Cases | Static/Dynamic Cambinations | Lumped Masses | Srubbers | Contral Parameters | Advanced |

el I - I~ -~ -~
2 [
33 |:| #P300.DLF FREQ FORCE LIN LIN
34 |:| #P150.DLF FREQ FORCE LIN LIN

Figure 17. Spectrum Definitions in CAESAR II.

The data points contained in the graph do not exist within this dynamic input. If they did, you would be
able to view the F-T data using the spectrum data set button. In this case, the data is instead contained in
separate files in the working folder. The octothorpe (#) preceding the name tells the dynamic input to go
find the data in this file in the current working folder.

These spectrum definitions require no editing. There are two response curves defined, both having a
horizontal axis of Frequency, and vertical axis of Force, and both axes are linear in scale (as opposed to
logarithmic). Selecting the next tab to the right, ‘Force Sets’ shows the correct loading and location, but
the direction column requires us to make a selection (X/Y/Z). In Figure 18, the Direction column has
been edited to set the correct direction for each force set. Note that the maximum load has been
extracted from the force-time data and has been placed in the Force input column for each force set
automatically by CAESAR II.
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Figure 18. Force Set Definitions in CAESAR II.

In the next tab, ‘Spectrum Load Cases’, the response curves have been matched to the force sets to
create two load cases. Again, the direction column must be set by the user. This needs to be done for
both load cases, so after editing this in the first load case, you click the arrow that changes the displayed
load case so you can see and change the second load case direction setting.

15 - [ZA\SEMIMNARS\! SAR T SEMINARNCEASAR- MEMORY STICK FILES\CAESAR T SEMINAR FINISHED FILES\WALVE CLOSU .= X

i Fle Edit Tools |I‘\IT-ER?5I_:<}\FH'
¢ Analysis Type: Water Hammer/Slug Flow (spectrum) o @ & e |_ E Al e

Spectrum Definitions I Force Sets| Spectrum Load Cazes | Static/Dynamic Combinations | Lumped Maszes I Snubbers | Control Parameters | Advanced |
- = Stress Types n Add Mew Load Case
Editing Load Caze ulj
l:l Delete Current Load Case
cmt | Spectrum Factor | Dir. | Force Set # |
Y ]
1 & P300.0LF 1.0000 | & [=]1

Figure 19. Spectrum Load Cases in CAESAR II.

Although it is typical to combine both load cases together, this is not how the input has been created by
the import utility. To combine the load cases, a third load case would be added (top-right button: Add
New Load Case), with two lines of input data that includes both loads together. One of the
shortcomings of Spectral analysis is that there is no sense of timing, so the addition of loads and modal
responses tend to be on the conservative side, unless harmonic load magnification is an issue.

The next input tab is “Static/Dynamic Combinations’, where static cases can be combined with dynamic
cases to check combined stresses for code compliance, and to check combined restraint loading.

En Dynamic Analysis - [ZASEMINAR SART SEMINAR\CEASAR- MEMORY STICK FILES\CAESAR T SEMINAR FINISHED FILES\WALVE CL

! File Edit Tools INTERGRAPH'
i Analysis Type: Water Hammer /Slug Flow {spectrum) o @ Bl e I_ t Al s

Spectium D efinitions I Force Sets I Spectum Load Eases| Static/Dynamic Combinations | Lumnped Maszes I Snubbers I Control Parameters I Advanced |
- = Stress Types ﬂ Add Mew Load Case
Editing Load Case of
l:l Dielete Current Load Case
cmt | Load Case | Factor |

g 0

1 [ |siowsusy 1.0000

2 l:l D 1.0000

Figure 20. Static/Dynamic Combination Load Cases in CAESAR II.
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The input that was created only combines the load cases required to check occasional stresses, that is,
combining Occasional (dynamic) stresses with Sustained (static weight & pressure) stresses for code
compliance. For restraint load combination cases, the user will have to add these cases manually.

The “Lumped Masses’ and ‘Snubbers’ tabs are ignored and left to the user to define if required.

The “Control Parameters’ tab typically requires that the Static Load Case be set to check non-linear
restraint status. If unfamiliar with this, the field-level help or documentation in CAESAR 11 should be
consulted. An Operating case is usually specified in this field. In this example we have only a
Sustained static case. If the CAESAR Il model is linear, no load case need be specified.

Control Parameter adjustment that will improve the accuracy of your analysis is setting the Mass Model
to “Consistent”. This comes at a cost of higher RAM requirements.

n Dynamic Analysis - [ZASEMINARS\CAESAR T SEMINAR\CEASAR- MEMORY STICK FILES\CAESAR T SEMINAR FIMISHED FILES\WALVE cLosu.—X
i File Edit Tools ~INTERGRAPH'
: Analysis Type: Water Hammer /Slug Flow (spectrum) = @ ﬁ F- E i

Spectrun D efinitions | Farce Sets I Spectun Load Cases | Static/Dynamic Combinations | Lurnped Masses | Snubbers | Control Parameters | Advanced |
Def | Setting | Parameter
1 (]| 1 visus)| |»| Static Load Case for Nonlinear Restraint Status
2 [ Jjoo Stiffness Factor for Friction (0.0-Not Used)
3 o Max. Mo. of Eigenvalues Calculated (0 - Not Used)
4 ]33 Frequency Cutoff (Hz)
5 — Jfo Closely Spaced Mode Criteria
[+ :] N Re-use Last Eigensolution (Freguencies and Mode Shapes)
7 [ ]| mopaL Spatial or Modal Combination First
8 [ ] sRss Spatial Combination Methed (SRSS/ABS)
9 [ ]| GrRoupP Modal Combinatien Method (GroupM0%/DSRSS/ABSISRSS)
10 — Jr Include Migsing Mass Components (v/N)
11 :] SR55 Missing Mass Combination Methed (SRSS/ABS)
12 [ JjaBs Directional Combination Method (SR3S/ABS)
13 [ || consISTENT Mass Model (LUMPED/CONSISTENT)
14 :] Y Sturm Sequence Check on Computed Eigenvalues (viN)

Figure 21. Setting Control Parameters in CAESAR II.

As a summary of the combined load results in this Spectral analysis, the results show:

e Maximum stress = 158,230 kPa

e Maximum displacement in the Z direction (along the axis of the valve) = 193.86 mm

e Maximum displacement in the Y direction (along the axis of the vertical run) = 7.48 mm
e Maximum displacement in the X direction = 282.27 mm

The piping model is well restrained in the vertical direction, but mostly unrestrained in the horizontal
plane, which would explain these relative displacements (support friction is not being considered in this
case).

Time-History Analysis Method

The input required for Time-History analysis is almost exactly the same as that for Spectral analysis.
Both require the same force magnitude, direction and location. Both will incorporate the same force-
time data. Static and Dynamic Load Combinations are also input the same way. The fundamental
difference is that, in Time-History analysis the force-time data is applied directly to the model, and the
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response is evaluated at incremental steps in time through the event. Spectral analysis instead converts
the force-time data into a maximum-response curve that is matched to the natural frequencies of the
piping system. Unlike Spectral analysis, Time-History considers the timing of events, and considers the
kinetic energy of the system in motion during the event. Also, Time-History input is not automatically
created for us, so we have to manually input more of the data to perform this analysis, even if AFT
Impulse is used in the transient hydraulic analysis.

The force time data generated by Impulse for the Spectral method is not in the format required by Time-
History input, and the unit requirements are different also. Time-History requires millisecond units in
the force-time input, while Spectral required seconds when importing AFT Impulse data.

Fortunately, Impulse provides an easy way to export numerical X-Y data of all kinds in a general format
that can be used for Time-History force-time input.

Looking back at Figures 7 & 11 in the Graph Results window and the graph of force imbalance over
time, this graphed data can be copied to the Windows clipboard using the “Copy X-Y Data” button from
the Edit menu and then pasted into another data-handling software such as Microsoft Excel:

Edit |

CErl+C

r‘“
© ¢ Clear Inttial Guesses, .,

Figure 22. The AFT Impulse Edit menu has a feature for copying numerical data from graphs.
Note this feature is only visible on the File menu when working in the Graph Results window.

The AFT Impulse File menu has an option for saving the graph’s numerical data directly to a file:
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: D e

‘= Cpen... Chrl+o
Impork Graph Data. .,

H Save Chrl+5
Save As...

Save Graph As...

Save Graph Data As...

Expark Force File »

& Print... Chrl+P
% Print Preview Special. ..
@ Prink Setup...

Start Bakch Rum. ..

'E Create Adobe POF...

1L Avalve closure with pipe Forces.imp
2 2L Avalve Closure.imp
3 0. AModelsivalve closure with pipe Forces 2.imp

4 . \Modelsialve closure with pipe Forces.imp

Exit

Figure 23. The AFT Impulse File menu has a feature for saving numerical data from graphs to a
text file. Note that this feature is only visible on the File menu when working in the Graph
Results window.

The recommended procedure from here is to first copy the force-time data from Impulse, then paste it into an
Excel spreadsheet, and then later copy/paste it into the Force-Time input grid in CAESAR II. Before you can
paste into CAESAR II’s dynamic input though, you must first create your force-time graphs in the Spectrum
Definitions tab.

Access the Dynamic Analysis module, and select Time-History Analysis as the analysis method.

Highlight and delete the spectra that are default-loaded in the Time-History Definitions (optional), and click on
the red & white + button to add some blank data lines.

Here we first define the name and axes of the Force-Time graphs.

The name can be anything, but it is wise to use node number in the name. This helps keep track of your data as
the number and locations of loads increases.

Set the graph names and axes to TIME, FORCE, LINEAR, LINEAR for each graph.
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! Fle Edit Tools INTERGRAPH
: Analysis Type: Time History

Time Histary D efinitions | Farce Sets | Time History Load Cases I Static/Dynamic Combinations | Lumped Masses I Snubbers I Control Parameters I Advanced |

Cmt Name Range Ordinate Range Ordinate

Type Type Interpol Interpol
o |:| TH300 TIME FORCE LINEAR LINEAR
1 |:| TH150 TIME FORCE LINEAR LINEAR

Figure 24. Time-History graph definitions in CAESAR II.

Next, use the “scatter-plot-looking” button to launch the dialog that lists your graph names. With the
first graph, select the name and click OK.

[

This launches the force-time input dialog:

" Spectrum Name : TH300

+|.4
‘ Range DLF { Ordinate
{milliseconds) (N.)

1
0.8
06
04
02

0

0 01 0.3 05 07 09 1
’ ak. ] [ Cancel ]

Figure 25. Force-time data input dialog in CAESAR 1.
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Ideally, one would then copy the Excel data from Impulse & paste it into this window. Unfortunately, as
of the time of writing this, in order for this dialog to accept the pasting of data, you must first click on
the “ + ” button the number of times it takes to create the number of blank rows required. Yes, really.
(And no blank lines are allowed.)

It sounds like a lot of unnecessary work, but does not require a lot of time. In this example, about 800
data rows were created in about 2 minutes. The ability to more easily copy/paste into these fields is on
the development wish-list.

Spectrum MName : TH300
+|.¢&
Range DLF i Ordinate | ~

[millizeconds) I N.) E
0 0.0000 0.0017 1
1 42451 3.1485
2 5.4501 52984 08
3 127382 9.4420 0.6
1 16.9803 ~11.0298
5 212283 126436 04
6 25.4704 142687 0.2
7 29.7155 -15.9088
5 33.8605 175445 0

0 01 0.3 0.5 0.7 09 1
9 332056 192033 | -
Read From File...
| Ok | | Cancel |

Figure 26. Force-time data [Ctrl]-V pasted into dialog in CAESAR II.
Here are some of the results from the Time-History analysis:

e Maximum stress = 261,400 kPa

e Maximum displacement in the Z direction (along the axis of the valve) = -224.02 mm
e Maxim displacement in the Y direction (along the axis of the vertical run) =-2.14 mm
e Maximum displacement in the X direction = 271.27 mm

In comparison to the Spectral analysis results, the Y and X displacements are quite similar in magnitude, but with
Time-History analysis, the Z direction displacement is about 15% higher (and the opposite sign), and the stress is
about 65% higher than predicted by Spectral analysis.

Spectral analysis loses its loading signage (plus/minus) through the process of SRSS summations of individual
modal responses; everything gets squared, added together and “square-rooted”, so all negatives disappear. That
is, you won’t see a negative value in the output results.

Spectral analysis will often provide similar, but slightly more conservative results than Time-History analysis, but
when harmonic amplification occurs due to the alignment of natural frequency responses with oscillating loads,
Time-History analysis can predict much higher resulting system response that Spectral analysis is simply
incapable of capturing.

With the advantages of Time-History over Spectral analysis, you are certain to see this as an option in the AFT
Impulse import utility in a future version of CAESAR 11, as Intergraph’s development staff have confirmed that
this capability will be added to the software.
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Limitations in Creating Accurate Force Data

Transient force imbalances are sensitive to the difference in pressures at a given time. This means it is
sensitive to the speed of the pressure wave (wavespeed or celerity). When waterhammer pressures drop
to vapor pressure then transient vaporization can occur. It is well known that vapor or gas in a pipe
changes the wavespeed. This is difficult to model using modern methods and hence, force generation
under cavitating conditions is not reliable.

Conclusions

It is important to model waterhammer events for proper system design and operation. AFT Impulse can
generate transient forces that include friction, momentum and in-line component loading which can then
be easily imported into CAESAR II. The difficulties and uncertainties in manually predicting load
magnitudes, load differentials and the relative timing of these loads makes computer-based transient
analysis a requirement in most cases where transient hydraulic loads must be predicted and understood.

Employing analysis for both the hydraulic transients and mechanical response naturally provides more
accurate results than manual approximations, but an important added benefit is the ability to examine all
possible solutions to a problem. Instead of simply adding more restraint or reinforcement to stop a
system from moving or breaking, sometimes hydraulic system modifications can provide a less
expensive, safer solution.

A zip file of the files used to prepare this paper can be downloaded at:
http://www.codecad.com/AFT-C2.zip

Note that, with the Control Parameter settings in the Time-History example used, it may be necessary to increase
the amount of RAM allocated to CAESAR |11 using the Configuration/Setup utility.

Questions or problems related to the application of the software can be addressed by email to:
support@codecad.com or support@aft.com.
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